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Getting Started 

What is QCTool 
 

 

 
QCTool provides you with an efficient means of data quality control prior to advanced processing and interpretation. It is 

not confined to a special type of data and can be used in any scientific field where data analyses and handling are 

involved. It offers three modes of data display - tables, grids and plots, which, being interrelated, make the cumbersome 

job of data checking and editing as easy as a click of the mouse 

 

 

Terms (Notational Conventions) 
 

Point a row of a table (a single data point sample with N associated data channels)  

 more commonly termed a record in a data file 

Channel data representing the same characteristic and forming a column of a table 

Line a data subset in a sequence of measurements represented in a spreadsheet within the file 

 

Fiducial Channel a channel containing reference information (time of measurement, etc.) arranged in a 

certain order; as a result each point has its own fiducial, an index to be utilized as a 

basis for merging different data sets (files) 

Grid a 2D array of data points 

Interpolation the process of estimating data at the vertex of a grid based on the data collected at 

irregular data points 
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Importing Data 

 
How to Import Data to QCTool 

1. Select File/Import File. The Import Formats dialog appears, allowing wide variety of formats: 

 
 

 

 

2. Select a required format and click OK. In the Windows-style Import File dialog to open, browse for the file to 
import. 

 

 
QCTool permits import of the following data formats: 

 

 ASCII XYZ(.txt, .xyz,.dat) 

 ASCII CVS(.cvs) 

 Binary XYZ 

 GDD, GEM, Geomtetrics, Geonics, GSSI 

 IRIS, Micro-g, Phoenix, SeaSPY, Zonge, Scintrex 

 EDI, TBL, USF, AMIRA, LAS 

 Geosoft GBN, GDB 

 GARMIN, GPX, IAGA, BIL 

 GTOPO, CDED, USGS DEM,  

 GXF, SURPAC,  

3. Save As dialog, offering you to save your file as a .qct file. You can leave the old name of your file or, if desired, 
rename it. 

4. Click OK to import. 
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ASCII Columnar Format 

If you are importing the ASCII data, the Import: Set Channels dialog appears: 
 

 

To specify the header line 

 
If a file of data to be imported has a single-line header, the latter is automatically displayed as a header in the Data 

Preview table. 

 
If the initial header consists of two or more lines, each column in the Data Preview table is assigned a consequent 

number (Ch1, Ch2 and so on), whereas the File Header field below offers a number of choices. 

 

 Select a header line (preceded by a slash / ) in the File Header field. 

The standard delimiters between columns are a space, a comma, and a tab. If this is the case, skip this paragraph and go 
to the next step. If you have a different delimiter in your initial file, click the Set Header Delimiters button to open the 

Delimiters dialog. Check the Other box and specify the kind of the delimiter used in the now active field to the right. 

 
 Double-click the selected header line to incorporate it into the table. A message asks you to confirm the 

replacement. 
 

 Click OK to confirm. 

If the File Header field does not contain any items, it means that the first line of the file to import is not marked as a 

comment line (preceded by a slash "/"). In this case: 

 
 If you have one first line, select 1 from the Skip first rows dropdown list above the Data Preview table. If you 

have two or more first lines, select the respective number. This removes the first line(s) from the table and places 

it (them) in the File Header field. 

 In File Header field, double-click a required line to insert it as a header in the Data Preview table. 

 Click OK in the confirmation dialog to appear. 
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To specify the format of data to import 

 
You can specify the format of each column of your data: 

 
 Select a column in the Data Preview table of the dialog. Note that the table contains only a portion of the data to 

be imported (about 20 rows). 

 
In the Column Format section: 

 Select the General Text button if a column contains text. 

The box to the right shows an automatically estimated maximum number of characters per row in this column. Since the 

estimation is based on the portion of data displayed in the Data Preview table, you probably will want to edit it. For 

example, your data set contains 10,000 points with record numbers from 1 to 10000. The Data Preview table displays 

only 20 first rows with record numbers not exceeding 2 characters. As a result, the General Text box contains a 

2- character estimate. To provide for your 5-character data, change 2 to 5. 

 
 If your data contains date or time and you want to edit its format, click on the header of the respective column, 

turn the Date or Time button on and select the required format from the dropdown list. 

 Select Skip Column to remove a column from further processing. This option is especially convenient when a 
column contains text and there is no point to subject it to processing. 

 Select between the single- (4-bite) and double- (8-bite) precision and between a short (2-bite) and long (4-bite) 
integer. 

 

 Repeat the same procedure for other columns. 

 Check the Use a Column as a Line Label box to have a separate table for each data subset, or line . 

It applies if every row of your initial data contains a line number. In this case all line numbers are imported into a separate 

column. If you select Skip Column to remove it from the table, QC Tool will still use information from this column to 

perform the subdivision by lines. Note. Currently, this subdivision is possible only if lines in your initial file are identified by 

the word   LINE . 

 
All above steps performed, click Continue to complete data import. 

 
Note. The format adjustments will show only after import. 

 

Binary XYZ Format 

If you are importing the binary XYZ format, the Binary File Import dialog appears:

 
 

 Specify the number of channels in a record in the box at the top of the dialog and click Set. 
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The table below and the Data Format section become active. 

 

 Click on the cell in the Name column of the table to enter the name of the channel and on the cell in the Units 
column to enter the units of measurement. 

 

 In the Read Format section, select between the four options, 16-bit integer, 32-bit integer, 32-bit float, and 64-bit 
float. The Write Format section changes accordingly. 

 

 Click Set for Selected to insert the data format in the selected row of the table 
 

OR 

 
 Click Select All Channels to select the whole table and then Set for Selected to add the same data format to all 

rows. 

 
All channels having been specified, the File Records section in the bottom left-hand corner of the dialog becomes active. 

 
 In this section, check the total number of records in your file and specify, if required, an interval to be used to cut 

your data into lines. 

 

 In the Fiducial Channel section, leave the Fiducial Channel box checked to add this channel to your table and 

insert the value of sampling frequency in the respective field. This sampling frequency could represent any 

quantity to be used to number or order the data. For example, if the sampling frequency were set to be 1 then the 

Fiducial would simply be the record number. As pointed out in the Terms section, an important purpose of this 

channel is to provide basis for merging different data sets. 

 

 Click Continue to complete data import. 

Geosoft GBN,GDB file import 

 Select File/Import on the QCTool menu. The Import Formats dialog appears. 

 From this dialog, select Geosoft GDB/GBN and click OK. In the Import file dialog to appear, browse for a required 
*.gbn/.gdb file and click Open. 

The standard Windows-style Save As dialog opens, offering you to save your *.gbn file in the *.qct format. 

 

 Click OK. 

The GDB/GBN File Import dialog that appears contains general information on your file - the number of lines and the 

number of channels in a record. The left-hand table below shows all the channels available in your file; the right-hand 

table shows all the lines available in your file. 
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 Select or deselect the channels to import in the Channels table. You can do it manually by checking or clearing 

the boxes in the Exp column. Or, you can select one or more channels at a time and use the Check Selection 

and Uncheck Selection buttons in the right-hand part of the dialog. 

 Specify the output data format for each channel in the respective section. Click on a channel in the table, select a 
required option from the five available formats below and click Set for Selected. 

 Select or deselect the lines to import in the Lines table. You can do it manually by checking or clearing the boxes 

in the Exp column. Or, you can select one or more channels at a time and use the Check Selection and 

Uncheck Selection buttons under the table. 

 Check the Import Fiducial as a separate channel to provide the respective operation in case your file contains 
an appropriately ordered column. 

 Click Continue to complete import into QCTool. 

INSTRUMENT MANUFACTURER’S FORMAT EXAMPLES 

Scintrex CG3 Dump Format 

On selecting Scintrex CG3 Dump in the Import Formats dialog (see How to Import Data), the Scintrex CG3 Dump 

Import dialog appears: 

 

 

 In the Columns in File field, select columns that you want to import and click the  button. The selected 
columns will appear in the Columns to Import field. To remove a column from the Columns to Import field, 

select this column and click the  button. 

 Select a required date and time format from the respective dropdown lists below. 

 Leave the Sort All by Time Channel box selected to sort your data by time in ascending order. If you de-select 
this box, you data will appear in the same order as in the raw file. 

 

 Click Import. 

 

  
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Working With Tables 

 
Tables Overview 

Import completed or an existing *.qct file opened, a spreadsheet-like three-dimensional table appears containing data in 

the format you specified (see How to Import Data to QCTool). This table has depth and can be divided into as many 

smaller tables as the number of data subsets, or lines , in the initial file. They can be further subdivided inside the 

application. You may also have a version that allows merging of these subsets or lines . The links between the tables 

differ from those used in similar applications, like Excel, since QCTool provides a very strict data structuring. The tables, 

numerous as they may be in a file, all have the same data structure and, therefore, are easy to shuffle through and to work 

within. 

 
See Also 

 
Change the Format of Data 

 
Change the Colour and Font of your Spreadsheet 

Copy and Paste Data in your Spreadsheet 

Rename a Column Header 

Insert a New Column 

Delete/Restore a Column 

Calculate/Recalculate a Channel, Create Row Indices 

View the Channel Statistics 

Delete a Single Value 

Delete/Restore a Point (a Row) 

Delete/Restore a Line (a Table) 

Remove Outliers 

Cut a Line into Two or More Parts 

Rename a Line 

Shift Position 

Insert Points 

Break Lines 

Merge Lines 

Print Selected Data 
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To change the format of data 

Although you specified the format of your data before import, you may decide to change it during your further work. You 

can easily do this right from the table. 

 Click on the header of the column, the format of which you want to change, and select the Column Format 

button  in the second row of the QC toolbar that is available when you work with spreadsheets 

OR 

 

 Right-click on the column header and select Column Format from the popup menu to appear. 
 

The Column Format dialog appears: 

 

 
In the Data Display Format section of the dialog: 

 
 Select a required format from the dropdown list. For single- or double-precision data, you have the Fixed and 

Scientific options. If your data represent Date or Time, select one or the other from this list. This activates the 

Template Format menu which, depending on your selection, will offer you various formats of date and time. 

 Specify the number of digits after the decimal point in the respective box. 

 Click Apply. 

To change the colour and font of your spreadsheet 

Select View/Spreadsheet Font on the QCTool menu. The standard Font dialog opens: 
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Make your adjustments as required and click OK. The changes will apply to the entire spreadsheet. Being saved in your 

computer, the settings will remain the same even if you switch to another line/data set or close QCTool and open it again. 

 

To copy and paste data in your spreadsheet 

The Copy and Paste functionalities are similar to those available in all like applications. 

 

 Select the cells/rows/columns you want to copy and click the Copy button  on the QC toolbar (or press 
Ctrl+C). 

 Place the cursor where you want your data to appear and click the Paste button  on the toolbar (or press 
Ctrl+V). 

 

Note. In this version, the Undo button is not available, and you have to delete the pasted data (see Delete a Single Value, 

Delete a Point (a Row), Delete/Restore a Column). 

 

 

To rename a column header 

 Right-click on the header to change and select Rename Channel from the popup menu to appear. The 
respective dialog opens: 

 
 

 

 Change the name and, if necessary, units in this dialog. 

 Click Apply. 

 

To insert a new column 

 Right-click on the header of the column, next to which you want to create a new column. 

 In the popup menu to appear, select Insert Channel. The Insert Channel dialog opens: 
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 In the Insert section, specify the location of a new column relative to the column selected. 

 In the Data Type section, specify the format of data this column will contain. 

 Specify the header of the column in the Channel Name box and the units of measurement in the Channel Units 
box. 

 

 Click Insert. 

To delete/restore a column 

 Right-click on the header of the column to delete. 

 In the popup menu to appear, select Delete Channel. The column will get highlighted in mauve, which means 
that it has been removed from processing. 

 To restore an earlier deleted column, right-click on its header to bring up the popup menu and select Restore 
Channel. 

 

To calculate/recalculate channels, create row indices (Formula 

Calculator) 

The Formula Calculator is used in the following cases: 

 

 When you need to recalculate values in a number of cells of a column 

 When you need to recalculate a whole column 

 When you need to calculate a new column; in this case, prior to the calculation, insert a new column as described 
in Insert a New Column 

 When you need to assign each row an index. 

To bring up the Formula Calculator: 

 
 Select a required number of cells in the column or double-click on the header of this column to select all the cells 

in it and click the Transform Data button . 
 

OR 

 
 Right-click on the selected cells/column/newly-added column and select Transform from the popup menu to 

appear. The Formula Calculator dialog opens: 
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In this dialog: 

 

 The Result dropdown list shows the index (a letter) of the column for the calculated value to appear. 

 In the Formula section: 

 Work out your formula using the standard Functions and Numeric keyboards below. The 

Columns keyboard inserts the indices (letters) of the columns and is used if your formula is 

based on the values from other channels. 

 Use the standard Backspace and Delete buttons to edit your formula. 

 Click the Save button to save your formula as a .fml file, so that in future you can use it again. 

 Click the Load button to load a .fml file and use an already available formula. 

 Click the Clear button to remove or replace the formula. 

 Click Check Formula to make sure that the formula contains no errors. In the Formula Result 
section below, you will see a sample of calculation for the first row or, if your formula is 

incorrect, an error message. 

 

 In the Rows section of the dialog: 

 Specify the range of rows in a new column to contain the calculated parameter. If you have 

already selected a certain number of rows right in the table, the From and To fields will contain 

the first and the last number of these rows, respectively. 

 Check the All Rows box to select all rows. The From and To fields will become disabled. 

 Check both the All Rows and All Lines boxes to select the same column throughout all of 
your tables (lines) 

 
Note. If you specify the first and the last row in the From and To fields and simultaneously 

check the All Lines box, the number of the rows to be selected in each table (line) will not 

exceed the range specified, no matter how many more rows the table contains. 

 To create indices for the rows specified in the Rows section of the calculator: 
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 Click row in the Functions section of the calculator if you want the indices to reset with each 
new line. 

 Click frow if you want the indices to continue throughout all of the lines. 

 Click Apply and Exit to close the dialog and see the results. 

 

To view the channel statistics 

 Select any group of cells in a given column. 

 Right-click on this group or on the column header and select Statistics from the popup menu to appear. 

 

To delete a single value 

 Right-click on the cell containing a value to delete and select Set Dummy Value from the popup menu to appear. 

This will replace the value by an asterisk and automatically remove it from further processing. 

 

To delete/restore a point (a row) 

 Select the point you want to remove. 

 Click the Delete Point(s) button   on the QC toolbar 
 

OR 

 

 Right-click on the point number in the first column and select Delete Point(s) from the popup menu to appear. 
 

The whole row will get highlighted in mauve, and the  sign will appear in the first column before the point 
number. 

 To restore a point, right-click on this sign and select Restore Point(s) from the popup menu to appear. 

Note. You cannot restore a point after you have closed your file and then open it again. 

 

 

To delete/restore a line (a table) 

Click the Delete Line button  on the QC toolbar. The line you are currently in is removed from the dropdown List of 
Lines on the main QC toolbar, whereas your spreadsheet automatically switches to the next line. 

 
However you can always restore the line you deleted: 

 

 Click the Line Info button  on the QC toolbar to open the respective dialog: 
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In the List of Lines, you can see the sign before the line you deleted. 

 

 Double-click this sign to restore the line. 

Use Shift or Ctrl key to select lines. Delete/Restore Selected Lines is enabled automatically. Click the button 

 

 

 
The values in the Total Number of Lines and Total Number of Points boxes in the right part of the dialog update 

accordingly to reflect the deletion or restoration of the line(s). 
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Note. You can also delete a line right in the Line Info dialog. Double-click on the line you want to delete, and the sign 
will appear to indicate that the line has been removed. 

 

To remove outliers 

 Right-click on the header of the channel and select Outlier Removal from the popup menu to appear. The 
respective dialog opens: 

 

 

 The Channel field contains the name of the channel you selected. 

 Check the Minimum and Maximum boxes and type in the cutoffs. 

In the Apply to section, select Current Line to remove outliers only from the line you are currently working with and All 

Lines to remove outliers from all available lines. 

 
 In the Outlier Points section, select Delete to remove the whole rows containing outlier points. The rows 

highlighted in mauve mean that the respective points have been deleted. 

 Select Set Dummy Values to replace all the outliers in the column with asterisks and thus remove them from 

processing. If later you want to delete the whole rows containing the dummy values, check the Delete Points 

with Dummy Values box. The rows highlighted in mauve mean that the respective points have been deleted. 
 

Note. To restore the points, select them in the record number column (N), right-click, and choose Restore Point(s) from 

the popup menu to appear. 

 

 Click Apply. 

 

To cut a line into two or more parts 

 Select the point where you want to cut your line into two portions. 

 Click the Cut Line button   on the QC toolbar. 

In the dropdown List of Lines, both portions retain the original number of the line, with the second portion also having the 

extension _1 . 

 

 Repeat these steps to make as many cuts as desired. 
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To rename a line 

 Click the Line Info button  . The respective dialog appears: 

 
 

 

 In this dialog, select the line to rename from the List of Lines. 

 Type a new name in the box to the right of the List of Lines and click the Set Name button. 

To shift positions 

In some cases, you need to shift your coordinates by the distance between the receiver and the GPS station if, during the 

survey, they were located in different places. 

 
Select Tools/Shift Positions on the QCTool menu. The Shift Positions dialog opens: 

 

In this dialog: 

 

 Select the coordinates to shift from the X coord. and Y coord. dropdown lists in the Position Channels section. 

 Specify the In-Line Distance in the respective box in the Shift Parameters section and select between the 
Behind and Ahead options depending on the receiver position relative to the GPS station. 

 Click Shift. The results are added to the automatically created columns next to the columns with the former 
coordinates. 

 
 

Print Selected data 

Click File -> Print Selection Area. The dialog appears. 
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 Select All profiles or current profile 

 Select all rows or selected row range 

 Select all channels or selected channels 

 Select sheet order 

 Click Apply to set data selection 

 Click File->Print preview or File->print to preview or print selected data 

 

Break Lines 

Click the Tools -> Lines -> Break Lines. The dialog appears. 
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 Input a file name for saving the result 

 Select a data channel for breaking lines 

 Select the check box of Sort the selected break   if you want to sort the name of lines 
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Plots and Grids 

 
The QC Plot and QC Grid provide a graphical representation of your imported or processed data. They facilitate 

preliminary estimation of your survey results and allow fast and efficient detection of erroneous data. For your 

convenience, you can arrange your window (this option is available from the Window menu) to simultaneously view your 

plot, grid, and the respective table. Selecting any point in the plot or grid will automatically highlight its value in the table. 

 
See also 

 
Working with Plots Working with Grids 

Plot Data Grid Data 

Switch Between Curves on the Same Plot Change to Another Channel 

Set the Same Scale for All Channels Edit Data from the Grid 

Display Plots by Segments Zoom In and Out 

Switch Between Lines Zoom In on a Grid Fragment 

Set a Channel as the X Axis Move Grid Elements 

Adjust the X Axis Settings Measure the Distance Between Points 

Edit Data from the Plot Interpolation 

Zoom In on a Plot Fragment Grid Customization 

Customize the Plot Appearance Calibrate a Map to Use as a Grid Underlay 

Remove a Plotted Channel 

Remove a Trend PRINTING GRIDS AND PLOTS 

 
 

 

Working With Plots 

To plot data 

 Click on the header of the channel to be plotted and engage the Plot Data button   on the main toolbar 
 

OR 

 

 Right-click on the header and select Plot Channel from the popup menu to appear. 
 

The plot is generated automatically. Below the main toolbar, the QCPlot toolbar appears: 
 

. 

 

To switch between curves on the same plot 

You can select as many channels as you like and they all will be displayed in different colors on the same plot. But you 

can view plots of only one line at a time. To switch between the curves: 

 

 Double-click on the curve you want to switch to 
 

OR 

 

 Select the respective column in the table. 
 

The y-axis labels will change their color to that of the curve you switched to; the scale and units of measurements will also 

change accordingly. 
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To set the same scale for all channels 

 Click the Panel Settings button  on the QC Plot toolbar. The respective dialog appears: 
 

 Check Same Scale for All Channels and click OK. The Y-axis turns black, which means that it has become 
general for all the curves. 

 De-select this option in the Panel Settings dialog to return to the initial view. 

To display plots by segments 

If your line has too many data points, it is often more convenient to plot it by segments. 

 

 Click the Panel Settings button on the QC Plot toolbar. The respective dialog appears: 
 

 In this dialog, check the Display Data by Segments box. The Total Number of Segments box becomes active. 

 Specify the number of segments to divide your plot into and click OK. The plot will display first segment by 
default. 

 To toggle through the segments, use the forward and back arrow buttons or select the required segment from the 

Current Line Segment dropdown list on the QC Plot toolbar: . 

 

To switch between lines 

 Select a required line in the dropdown List of Lines on the main QC toolbar: 

. The plot automatically switches to the line you selected. 

 

To set a channel as the X-axis 

 Click the Change X Axis Channel button  on the QC Plot toolbar 
 

OR 

 

 Double-click the X-axis label in the bottom right-hand corner of the plot. 
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The Set X Axis dialog opens: 

 

 
 Select a required channel in this dialog and click Set. The X-axis will change to the scale of the selected channel. 

Its label will be replaced by the name of the selected channel. 

 

To adjust the X-axis settings 

Select the Change X-axis Scaling button  on the QC Plot toolbar or click anywhere on the X-axis. The X Axis 
Settings dialog opens: 

 

 

To edit data right in the plot 

If any error, your plot is distorted. 

 

 Click on the erroneous point. 

 To delete this point, click the Delete Point(s) button   on the main QC toolbar. Repeat it until your plot takes 
a normal shape. 

 To remove the whole line, click the Delete Line button . Your display will automatically switch to the next 
line. 

 To split a line into parts, click the Cut Line button . 

As a result, your line will be cut into 2 portions; with the first to be displayed by default. To display its second portion, 

select it from the dropdown List of Lines on the main QC toolbar: . It will have the same number as 
the first one and the extension _1 .. 

 

To zoom in on a plot fragment 

 Click the Zooming button  on the QC Plot toolbar. 

 Click and drag to select the fragment you want to magnify. 

 To return to the initial view, click the Home View button  on the QC Plot toolbar. 

To customize the plot appearance 

 Click the Change Plot Style button  on the QC Plot toolbar to bring up the Channel Style dialog: 
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 Select the channel you want to change the appearance of from the 
Channel dropdown list. 

 

 Select Linear or Log in the Channel Scale Mode section. 

 Click the coloured square on the right to adjust the color using the 
standard Windows-style palette. 

 

 Select the line style from the respective dropdown list. 

 The Line Width option is applicable only to Solid Line. Other styles 
do not show on the plot unless the minimum line width is selected. 

 

 Choose a required symbol from the respective list and change its size 
using the slider. 

 
This functionality is especially useful when you need to view the 

changes you are making right in the plot. For example, increasing the 

symbol size allows you to pinpoint deleted points. 

 

 In the Sample field below, you can simultaneously view an example of 
your changes. 

 
 
 
 
 
 
 

 

To remove a plotted channel 

 In the table, right-click on the header of the channel you want to remove from your plot and select the respective 
command from the popup menu to appear. The channel will be removed from the plot. 

 

To remove a trend 

Your data may often be influenced by various factors and as a result contain trends distorting its actual appearance. If it is 

the case: 

 

 Click the Linear Trend Removal button  on the QC Plot toolbar to bring up the respective dialog: 
 

The Processed Channel and Processed Line lists show the channel and line you are currently working with. To switch 

to another channel and line, select them from these two lists. 
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 To remove a trend from all lines of data, check the Apply to all Lines box. 

 To remove a trend from the whole line, check the Apply to all Rows box in the Rows section of the dialog. 

 To remove a trend from a certain portion of the line, specify the first and the last point of this portion in the From 
and To boxes. You can either type in the values or do the following: 

 
1. Click in the From box. The sign appears to the right, indicating that you are about to insert a new value in this 

box (you will always find this sign next to the boxes you are working with in the Rows or Trend Line Definition 

sections of the dialog). 

2. Click on the point of your curve which you want to be the starting point of trend removal. The X coordinate of this 
point appears in the From box. 

3. Click in the To box and then on the point of your curve which you want to be the ending point of trend removal. 
The X coordinate of this point appears in the To box. 

 
 To specify trend direction, enter the X and Y coordinates of the starting and ending points of the trend in the 

Trend Line Definition section. You can either type in these coordinates or insert them automatically by clicking 

on the respective points on the plot. 

 Since the result will appear not only in the plotter but also in the respective spreadsheet, select between the 

Overwrite and Create options in the Output Channel section of the dialog. If you select Create, a new column 

will be added to your spreadsheet containing the results of trend removal. If you choose the Overwrite option, 

the box to the right will turn into a dropdown list, offering you to select the channel to be replaced with a new one 

containing these results. 

 Click Apply. 
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To save a plot 

Click the Save As button on the QC Plot toolbar and follow the standard Save operations. 

 

Working With Grids 

To grid data 

 Click on the header of the channel to be plotted and select the QC Grid button   on the QC toolbar 
 

OR 

 

 Right-click on the header and select Grid Channel from the popup menu. The Set Channel dialog appears: 

 
 

 

 Select a channel to use as the X coordinate from the X dropdown list. 

 Select a channel to use as the Y coordinate from the Y dropdown list. 

 If required, reselect a channel to grid from the Data dropdown list. The channel selected by default is the one you 
specified in the table. 

 

 Check the X and Y - UTM coordinates box if the X and Y columns contain UTM coordinates. This will 
automatically draw the parallels over your grid. 

 

 Click Set. 

 
Your grid is generated. Each data point in the resulting stack of lines is assigned its own color. To see the value in a given 

point, click on the point and look its value up in the respective table. To move across the grid, you can also use the arrow 

keys. 

 

To change to another channel 

The generated grid uses the channels you specified in the Set Channels dialog (see To Grid Data). To change to another 

channel: 

 

 Select the  button on the QCGrid toolbar and go to the Lines tab. 


Click the Change Channel button . The Set Channels dialog opens: 
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 Reselect the channels in the X and Y dropdown lists. 

 Reselect the channel to grid in the Data dropdown list. 

 Click Set. 

No matter which display you had prior to or after interpolation, - your new display is not interpolated. 

 

To edit data right in the grid 

If any error, your grid display is distorted. 

 

 Click on the erroneous point and use the Delete Point(s) button   to remove it from the grid. Repeat this 
operation until you grid display becomes normal. 

 

 Use the Delete Line button  on the main QC toolbar to remove a whole line. 

 Click the Cut Line button   to cut a line into 2 or more portions. 

In this case, your change does not show on the grid unless you zoom in on the respective fragment (see To 
zoom in on a grid fragment). You can also check it up in the List of Lines on the main QC toolbar, in the 

respective table or plot, or in the Line Info dialog that opens by clicking the Line Info button . 

To zoom in and out 

 Use the Zoom In  and Zoom Out  buttons on the QC Grid toolbar under the main QC toolbar. 

To zoom in on a grid fragment 

 Click the Pointing scroll arrow  and select Zoom Selected  from the dropdown list. The cursor will 
change into a magnifying glass. 

 

 Click and drag to select a fragment to be zoomed. 

 To return to the initial scale, select Home View from the same Pointing list. 

Note. To change back to the arrow manipulator, select it from the Pointing list . 

To zoom in and out 

 Use the Zoom In  and Zoom Out  buttons on the QC Grid toolbar under the main QC toolbar. 
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To zoom in on a grid fragment 

 Click the Pointing scroll arrow  and select Zoom Selected  from the dropdown list. The cursor will 
change into a magnifying glass. 

 

 Click and drag to select a fragment to be zoomed. 

 To return to the initial scale, select Home View from the same Pointing list. 

Note. To change back to the arrow manipulator, select it from the Pointing list . 

To move grid elements 

 Select Move from the Pointing list . The arrow cursor changes to the hand manipulator . 

 Click and drag labels, symbols and other objects to the place you need. 

This functionality is especially useful when you need to customize the appearance of your grid (see the Grid 

Customization section). 

 

Note. To change back to the arrow manipulator, select it from the Pointing list . 

To measure the distance between different points 

 Select Distance from the Pointing list . You cursor changes to the ruler . 

 Click on the point to measure the distance from and drag to the point to measure the distance to. 

 Check the result in the Status Bar below. 

Note. To change back to the arrow manipulator, select it from the Pointing list . 

To perform interpolation 

During the interpolation process, QCTool interpolates data from data points onto a regular (rectangular) grid. You can 

interpolate the whole grid or its portion. In the latter case, before interpolation, zoom in on a required fragment as 

described in To zoom in on a grid fragment. 

 

 Click the Interpolate  button on the QC Grid toolbar. 

The Grid Settings dialog opens: 
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 Choose the method of interpolation in the Method dropdown list. 

By default, the Natural Neighbour option is selected. If desired, you can change it to Minimum Curvature. This enables 

the Max Iterations box below, for you to type the required number of iterations. 

 

 Edit the U Min, U Max, V Min and V Max settings as needed. 

 Increase or decrease dU and dV (number of points) or nU and nV (length of the grid cell side) to provide higher 
or lower resolution. 

 

 Change the dU and dV values and click in the nU and nV fields: the latter is recalculated automatically. You can 
reach the same effect by changing the nU and nV values and clicking in the dU and dV fields. 

 

 Edit the grid angle to examine your display from a different perspective. 

The grid has its own coordinate system (u,v) which is rotated from the coordinate system (x,y) chosen for the 2D display. 

In the example here, the grid is aligned along the x,y direction (angle = 0) and u is parallel to y . 

 

 Edit, if necessary, the X and Y reference points in the respective boxes. 

 If you are not satisfied with your changes, click the Default button to change back to the initial settings. 

 Check the Remove Extrapolated Points box and set a required spatial radius to restrict the area of 

interpolation. For example, a spatial radius of 55 means that if there are no data in the radius of 55 m around a 

given point a grid cell center, this cell will be removed from interpolation. 
 

Note. The interpolation process interpolates data onto the entire regular rectangular grid. However parts of this grid, which 

are far away from the data, may be overly extrapolated and thus should be removed for careful viewing. 

 

 Select between the slow and fast algorithms (slow is more accurate, but fast is almost always sufficient). 
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 Check the Remove Duplicate Points box to provide the respective operation. 

 Click Interpolate. 

The interpolation process can take some time depending on such grid settings as the number of initial points, grid 

dimensions or the interpolation method. 

 
If you interpolated only a grid fragment: 

 

 After interpolation, select Home View from the Pointing list  on the QC Grid toolbar. You will see the 
interpolated fragment stand out against the primary grid background. 

 

Customization Dialogs and Menus 

You can change the grid appearance using two methods: 

 

 Select the Show Layers dropdown menu  on the QC Grid toolbar and toggle on or off various features 
 

OR 

 














Select the button  on QC Grid toolbar or click right button 
select one for the advanced customization of your grid appearance. 

 

Related topics: 

 
Display and Customize Lines 

Change the Draw Mode 

Draw and Customize the Mesh Grid 

Draw and Customize Contours 

Display and Customize the Coordinate Grid 

 
Display Longitudes and Latitudes over a UTM-Based Grid 

Display a Grid Proportionally 

Use a Map Underlay 

 
Customize the Legend and Scale 

Customize the Grid Layout 
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To display and customize lines 

Click the button on QC Grid toolbar or click right button  select Lines. The dialog appears. 
 

 Check the Draw button to switch lines on and off (=Show Lines in the Show Layers dropdown menu on the QC 
Grid toolbar). 

 To assign the same colour to all of the lines, leave the Different Colors box in the Lines section unchecked. 

Select a required thickness of the lines from the respective dropdown list and click on the color square to the right 

to bring up the standard color palette. 

 To assign different colors to the lines, check the Different Colors box. Select a required thickness from the 
respective dropdown list. 

 To change the shape and size of symbols (points) on your grid, check the Data Symbols box. The Data 
Symbols section becomes active. Select the required shape and size from the respective dropdown lists. 

 To display the labels (line numbers), check the Line Labels box. Select between the four options below. The All 

button displays all labels, the Skip button every second label, the Start and End options the labels at the 

beginning and at the end of lines. 

 To edit the font and style of the labels, click the Font button  in the bottom right-hand corner of the dialog. 
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To change the draw mode of your grid 

Click the button on QC Grid toolbar or click right button  select Data. The dialog appears. 
 

 Select Equal Range to assign different colors to equal ranges independently of the number of points in each 
range or select Equal Weight to assign different colors to different ranges covering the same number of points. 

 
 Specify the range of data to be displayed (75% of data are displayed by default) using the sliders to the right of 

the Min Data and Max Data fields that show the absolute minima and maxima of your data. Or, type in these 

values manually. Click Apply. 

 

 Click on the colored squares to the right to open the standard Windows-style palette and to specify colors for the 
start and end of the data range. 

 
 

To draw and customize the mesh grid 
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Click the button on QC Grid toolbar or click right button select Grid Mesh. The dialog appears. 
 

 

 Check Draw Mesh to see your grid cells filled with color (=Show Interpolated Grid in the Show Layers 
dropdown menu on the QC Grid toolbar). This functionality is accessible only if your data have been interpolated; 

if not, a message prompts you to carry out interpolation. Click the Interpolate button  and follow the steps as 
described in To perform interpolation. 

 

The Draw Grid Symbols option displays each grid cell as a set of four data (vertices) and assigns a certain color 

to each data dependending on its value. 

 
The Draw Grid Cells option calculates the average of the data located in the vertices of a grid cell. The cell is 

filled with the color assigned to this average value. 

 
The Draw Cells around Grid Vertices option displays your grid as a set of cells drawn around each grid vertex 

and filled with a certain color assigned to the data value in the vertex. 

 
 If you selected the Draw Symbol button, select the shape and size of the symbols to be used from the respective 

dropdown lists in the Symbol section of the dialog. 

 

 Select the way for the color to fill the cells (Draw Symbol, Draw Cells, Draw Cell Around Vertex). 
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 Check the Grid lines box to draw the mesh grid. This functionality is available only if your data have been 

interpolated; if not, a message prompts you to carry out interpolation. Click the Interpolate button  and follow 
the steps as described in To perform interpolation. 

 Click the Load Grid from File button below to load an already available mesh grid. 

 Select the grid line thickness from the respective dropdown list and click on the colored square to the right to 
specify the color. 

 

 Change the density of your grid as needed both in the X- and Y-directions in the Skip Lines section. 

 Save your grid to use it later with other data. 

 

To draw and customize a contour display 

Click the button on QC Grid toolbar or click right button  select Contour. The dialog appears. 
 

 Check the Draw Contour Lines box to draw contours (=Show Contour in the Show Layers dropdown list on 
the QC Grid toolbar). This functionality is accessible only if your data have been interpolated; if not, a message 

prompts you to carry out interpolation. Click the Interpolate button  and follow the steps as described in To 
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perform interpolation. 

 Check the Fill Contour box to display filled contours. 

 Select between the color and black representation of the contour lines and labels. 

 Choose the number of contour levels and line thickness from the respective dropdown lists. 

 Check the Labels box to display the contour values and specify their format in the respective section (fixed or 
exponential, the number of decimal digits). 

 Use the Density slider to increase or decrease the amount of labels to be displayed and click the  button to 
adjust their font and style. 

 
 

To display and customize the coordinate grid 

Click the button on QC Grid toolbar or click right button  select Axes. The dialog appears. 
 

 Check the Major Lines and Minor Lines boxes in both the X-direction and Y-direction sections to show the 
coordinate grid. 

 Adjust the minimum and maximum coordinates in the respective boxes to display the portion of your grid you are 
primarily interested in. 

 Change the step between major ticks in the respective boxes to increase or decrease the density of your 
coordinate grid. 
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 Click the color square in the bottom right-hand corner of both sections to edit the color using the standard 
Windows-style palette. 

 Select between the Top and Bottom positions of the labels in the X-direction section and between the Left and 
Right positions in the Y-direction section. 

 Select the mode of outside and vertical positions of the labels in the X-direction section and the Y-direction 
section 

 Input thr number of Sub_Ticks of Minor lines in the X-direction section and the Y-direction section 

 Click the  button to specify the font and style of the labels in the standard Windows-style Font dialog. 

 Specify the number of decimal digits to be displayed in the respective box. 

Note.To switch the coordinate grid off, de-select Major and Minor Lines or de-select Show Coordinate Grid from the 

Change Layer dropdown list on the QC Grid toolbar. 

 

Display latitudes and longitudes over a UTM grid 

Click the Tools button  on the QCGrid toolbar to open the Tools dialog. Pin it and go to the Lines tab. 

On this tab, click the Change Channels button . In the Set Channels dialog that appears: 

 
 
 
 
 
 

 Check the X and Y - UTM Coordinates box and click Set. 

 Go to the Axes tab of the Tools dialog and click the Lat/Long button. The Lat/Lon Settings dialog opens: 
 

 
In this dialog: 

 

 Select between the W and E, N and S directions. 

 Specify the step in the respective boxes to the right. 

 Select a required ellipsoid from the respective list in the bottom of the dialog. 


Click OK. 

 

Back in the Axes tab, check the Longitude box in the X-direction section and the Latitude box in the Y-direction 

section. Longitudes and latitudes will appear over your grid. 
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To display your grid proportionally 

 Go to the Lines tab of the Tools dialog. 

 Check the Proportional View button. The sides of your grid will become of equal length. 

 

To underlay a map 

Click the button on QC Grid toolbar or click right button  select Map. The dialog appears. 
 

 Check the Draw Map (bmp) box. 

 Click the  button to open the Select a .map File dialog, a standard Windows-style Open dialog. Select and 
load a required map. 

 

Note. This map is to be calibrated before being saved as a .map file. See To calibrate a map. 

 

 Click Apply to underlay your grid with the map. 

 De-select the Draw Map box to remove the map. 
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To customize the legend and scale 

Click the button on QC Grid toolbar or click right button  select Legend. The dialog appears. 
 

 Check the Draw Legend box to display the legend (=Legend in the Show Layers dropdown menu on the QC 
Grid toolbar). 

 Specify the mode (Vertical or horizantal) 

 Specify the format (fixed or exponential), the number of decimal digits, and font ) for the values in the legend. 

 To move the legend, click on the legend and move it in a desired direction with the hand manipulator to appear. 

 Check the Scale box to authorize scale changes and bring up the scale rule. 

 Choose a required scale from the respective dropdown list and click Apply in the upper right-hand corner of the 
dialog (or click anywhere in your plot) to view the result. The scale rule will change accordingly. 

 Check the Draw North Arrow box in the bottom of the dialog to display an arrow pointing north. 

 

To customize the grid layout 
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Click the button on QC Grid toolbar or click right button select Margin & Title. The dialog 
appears. 

 

 

 Specify the margins around your grid display using the Left, Right, Top, and Bottom scroll lists 

 Type in the titles, click the  button on the right to specify their font and style, and click Apply in the upper 
right-hand corner of the tab. 

 Go the Legend tab: 
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 Check the Draw Text box to add comments to your display. 

Type in the field below, press Ctrl+Enter to insert a carriage return, click the  button to adjust the font and style of your 
labels and texts in the standard Windows-style Font dialog. 

 
 Check the Print Layout box in the upper part of the tab to switch to the print preview mode. In this mode, you 

can do any changes you need; for example, insert and move different elements (the legend, scale rule, title, 

comments) over your display, switch the coordinate grid off, edit margins, etc. 

 

To calibrate a map 

QCTool allows you to calibrate your map before using it as the underlay for a grid. 

 

 Click the PEGeoMap button  on the QC toolbar. 

In the PEGeoMap dialog to open: 

 

 Click A Windows-style dialog appears, offering you to select and load a raster format file (.bmp, .jpg, etc.). 


Click A Windows-style dialog appears, offering you to select and load a georeference file (.map,.jpw, .TAB, 
etc.). 

 
 

 

 The map loaded, specify at least three points to calibrate it to. 

 Double-click on the first point. The following dialog appears: 
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 Check the Polar box if your map comes from a polar region. 

 Select the required ellipsoid datum from the respective dropdown list. 

 Specify the central meridian and zone in the respective boxes. 

 Select between UTM and Lon/Lat (as a rule, QCTool recognizes this information). The respective boxes below 
become active. 

 

 Type in the coordinates of the point to add and click Add Point. Repeat this operation for other points. 

 To convert your UTM into Lat/Lon or vice versa, click Calculate. 

Note. It is necessary to recalculate Lat/Lon to UTM, since raster transformation is based on the UTM coordinates. 

 
 To check or change your points, click the Edit Points button. The Edit Entered Points dialog opens. Select the 

cell you want to edit and type in a new value. 

 Click the Clear Points button to remove all points. 

 Use the Shift Coordinates button to transfer to the local coordinate system. 

 Click Transform to start raster transformation. Do not forget to save the transformed image (Save Raster As). 
To also keep the previous image, save it with a new name. 

 

You can customize the appearance of the map: 

 

 To change the color to gray, click the Gray Scale button . 

 To change (diminish) the resolution, specify the pixel width and height in the respective boxes. 

 To add a line or any symbol to your map, use the buttons  and . If necessary, you can change the style of 
this line or symbol. Click the Draw Options button. Specify the colour, style and width of the line as well as the 

color, shape and size of the symbol using respective sliders and dropdown lists in the Change Style dialog. 

 To add an annotation to your map, click the  button. In the Annotations dialog that opens, write your text. Use 
the Font button to change the appearance of the text. 

 The Undo button  cancels any previous operation. 

 To zoom in on your map, click the standard button. To zoom out, click the  button. 

Having finished your work, save the transformed image (Save Raster As ) as well as a georeferenced file (Save 

GepMap ) to keep externals, originals and the name of the image. The geoferenced file(*.map,*.jpw,.TAB) files will 
then be available to other applications which can use the created raster image as an underlay. 

 

To save a grid 

Click the Save View As button  on the QC Grid toolbar and follow the standard saving operations. 

 Select Raster Type 
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 Select Raster Resolution 
 

 

 Select GeoMap Format, if chooses raster with georeferenced file 
 

 

Printing Grids and Plots 

To preview a grid/plot before printing: 

 

 Select Print Preview from the File menu. 

 Use the Next Page and Previous Page buttons on the Print Preview toolbar to toggle through available pages. 

 Click the Two Pages button to preview two pages at a time, click it again to switch back to the One Page mode. 

 Click the Zoom In button to take a closer look at your plot and the Zoom Out button to move it away. 

 To close the Preview mode, click Close. 

To print a grid/plot: 
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 Click Print in the preview mode to print the grid/plot right away. 

OR 

 
 Select Print from the File menu. In the standard Print dialog to open, specify printing properties and click OK to 

start printing. 
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Saving Files 

 
To save a file 

 Select Save File from the File menu (you can also use the standard Save button on the QC toolbar) to overwrite 
your old version. 

 

 Select Save As to create a new filename. 

To save data in other formats 

You can save your file in several formats: .qct (QCTool), .xyz (XYZ ASCII), .xls (Microsoft Excel), and .gbn (Geosoft GBN): 

 

 Select File/Save As. The Save As dialog appears. 

 Select a required format from the Save as Type dropdown list and click Save. The Export dialog opens. 

 

 In the Lines section of the dialog: 

 Select a line you want to export 

and click the  button. The line 
is moved to the field on the right. 

 

 To export all lines, click the  
button. 

 

 To cancel export, click the  

and buttons. 

 Select between the two options 

offered for the line label export: 

as a channel or in a separate 

line. 

 

 Check the Export Point ID as a 

Channel box to assign a special 

number (ID) to each row of your 

data and to export such numbers 

as a separate column. 

 

 In the Channels section, select the 

columns to export in the Existing 

Columns field and move them to the field 

on the right using the same method as 

described for the Lines section of the 

dialog. 

 

 Click Export. 

Note. If not indicated otherwise, the exported file will be saved with the same name, but a different extension. 
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Managing Files 

 
Managing Files 

In certain cases, you may need to work with various files simultaneously. To facilitate this task, the QC Tool offers its own 
File Manager. 

 
If you work with one file, have to switch to another, but want the first one to be at hand: 

 

 Close all the files one by one. 

In each case, a message will prompt you to click the Yes button if you want to close your file and the No button if 

you want to hide it, i.e. to put it aside for the time being . 

 Click No and continue your work with other files. 

 When you want to open the file you hid, click the File Manager button   on the main QC toolbar. 

The respective dialog appears: 

 

 

 Select the file from the Files list and click Activate. The file will open. 

You can also use the File Manager dialog to hide and close files: 

 

 To hide a file, select it from the Files list and click Hide. 

 To hide all the files, click Hide All. 

 To close a file, select it from the Files list and click Close. 

 

 

Note. When you have a blank screen, click the , and buttons on the main QC toolbar. This will 
automatically restore the tables, plots and grids you hid last. 
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Transverse Mercator Calculator 

Select Tools/Transverse Mercator Calculator to open the respective dialog: 

 

To convert Latitude/Longitude to UTM, click on the respective option in the upper left-hand section of the dialog. 

In the Input Channels section: 

 Select the channels you want to convert from the dropdown lists. As a rule, the Lat and Long channels are 
recognized automatically. 

 Select the axis direction between W and E, N and S in accordance with your data. 

As a rule, if longitude or latitude is negative, W and S are selected automatically. Otherwise, the you have to select the 

appropriate direction yourself proceeding from your data. 

 
 Make sure that the zone and central meridian information is correct. This information appears in the upper 

right-hand corner of the dialog after you have specified the input channels. 
 

In the Output Channels section: 

 
 Select Overwrite if you want to replace existing columns in your table. The UTM X and UTM Y boxes turn into 

dropdown lists. Choose the columns to overwrite from these lists. 

 Select Create if you want the results of your conversion to appear in new columns. You can leave the default 
header names offered by QCTool, UTM_X and UTM_Y, or change them as desired. 

 

To convert from UTM to Latitude/Longitude: 

 

 Click on the respective option in the upper left-hand section of the dialog. 

The names of the dropdown lists in the Input Channels section change to UTM X and UTM Y. 

 
 Select the channels you want to convert from these lists (as a rule, the UTM X and UTM Y channels are 

recognized automatically) and select the axis direction between E and W, N and S. 

 In the Output Channel section, select between Overwrite and Create as described above for the Lat/Lon to 
UTM conversion. 

 Specify either the zone or central meridian in the respective boxes in the upper right-hand corner of the dialog. 

 Click Process. 

Note. In both cases an ellipsoid datum is to be selected from the respective list in the bottom of the dialog. If your data 

come from polar areas, you also have to check the Polar Projection box. 

 

Merging Files 

QCTool allows two ways of merging files: updating one file with the data from another and merging two files using the 

same base channel (usually, the Fiducial channel). In both cases: 



50 Additional Functionalities 

50 Additional Functionalities 
 

 

 Close any opened files. 

 Select Tools/Files/Merging Files on the QCTool menu. The Merging Mode dialog opens, with the Update File 
Channels option selected by default: 

 

 

 Leave the Update File Channel option selected if you want to update your file or select Union of Files to merge 
two files, and click Continue. 

 

See also: 

 
Union of Files 

 
Updating Files 

 

Updating Files 

In some cases, you may need import separate columns from one file to another. This option is especially useful when you 

have two different files containing data of one survey; for example, one of the files contains the coordinates of your 

measuring stations and the other - the measured data. 

 

 Select Tools/Files/Merging Files on the QCTool menu. In the Merging Mode dialog that appears: 
 

 Leave the Update File Channels option selected and click Continue. 

The Merge Files dialog opens: 
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In the File 1 section of this dialog: 

 

 Click the Open button  to browse for the file to update. 

 Select the base channel from the respective list below. 

In the File 2 section of this dialog: 

 

 Click the Open button  to browse for the file, from which you want to import an update. 

 Select the base channel from the respective dropdown list below. 

The Save Merged Data in File field in the bottom of the Input/Output Files section contains the location of the result file. 

In the box below the Input/Output Files section: 

 Select the number of digits after the decimal point. This is a precision order QCTool uses to merge base channel 
data from different files. 

 

In the Merging Mode section: 

 
 Click the Set Channels button. The Select Colums to Update dialog appears, with the first column containing 

the data from the file to import. There are two ways of import. The first imports data into a new column of the file 

to be updated and the second updates an existing column. 
 

To import data into a new column: 
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 Click in the checkbox next to the column to import and leave New Column selected in the dropdown list that 
becomes active in the Columns: File 1 column. 

 

 Click Set 

To update an existing column: 

 

 

 Click in the checkbox next to the column to import and select the channel to update from the dropdown list in the 
Columns: File 1 column. 

 

 In the dropdown list that appears in the Update Mode column upon your selection, choose between three update 

modes: Replace (overwrites an existing column), Average (overwrites an existing column with the average 

calculated from the respective values in File 1 and File 2), and Replace No Data (overwrites only dummy 

values). 

 

 Click Set. 

Back in the Search for Update section of the Merge Files dialog: 

 
 Select between two methods of searching for the update: In All Lines (this option searches data in all available 

lines and sorts them in order) and In Respective Line (this option searches and sorts data within each separate 

line). If you select the second option, you can also specify the pairs of lines from File 1 and File 2. 
 

To do this: 
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 Click the Set Pairs of Lines button. In the Lines Link Table dialog that appears: 
 

 Select the line to update in the first (File 1) column. The second column (File 2) now contains a dropdown list with 
all the lines available in File 2. 

 

 Select a required line and click OK. 

Back in the Search for Update section of the Merge Files dialog: 

 
 Check the box next to Interpolate if Value is not Found if the column to import lacks a base channel vaue 

requested by the file to update. 
 

 Click Merge in the bottom of the Merge Files dialog. 

The Next Step dialog appears: 

 

In this dialog: 

 
 Select Start Another Merging Process if you want to import new updates into the same file or update another 

file. This brings the Merge Files dialog back. Repeat the steps described above. 

 Select Open the Result File in Read-Only Mode if you do not want to change the updated file. 

 Select Open the Result File in Read/Write Mode if you want to change the updated file. 

 Select Exit to quit the Merge Files application. 

 Click Continue to close the dialog. 

Union of Files 

In case your file contains a base channel, which is a column with values sorted in a strictly ascending order (e.g. Fiducial 

Channel), you can merge it with one or more other similar files. For this purpose, you do not need to open these files. 
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 Select Tools/Files/Merge Files. In the Merging Mode dialog that appears: 
 

 Select Union of Files. The Merge Files dialog opens: 
 

In the File 1 section of this dialog: 

 


Click the Open button to display the standard Open dialog. 

 Select the file you want to merge and click Open. Its name and path appear in the File 1 field. 

 Select the base channel from the dropdown list below, containing all channels from your file. 

In the File 2 section: 
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
Click the Open button to bring up the standard Open dialog. 

 Select the second file to merge with the one in the File 1 section and click Open. Its name and path appear in the 
File 2 field. 

 

 Select the base channel from the respective dropdown list below. 

 
In the Save Merged Data in File field: 

 
 Click the Open button to bring up the standard Save As dialog, select the folder to save the new (merged) file 

into, and enter its name in the File Name field. 

 

 Click Save to return to the Merge Files dialog. The name of the new file and its location appear in the Save 
Merged Data field. 

 

 
In the Base Channel Merging Precision field: 

 
 Specify the number of digits after the decimal point for the base channel in the box on the right. This is a 

precision order QCTool uses to merge base channel data from different files. 
 

In the Merging Mode section: 

 
 The Interpolate Channels box is checked by default. De-select it to cancel interpolation. The cells, which 

otherwise would have been filled with the results of linear interpolation, will contain asterisks. 

 To merge all data into one table without dividing it into lines, leave the Keep Data in One Line box checked (it is 
checked by default). 

 To divide a table into lines, de-select the Keep Data in One Line box and specify the number of points per line in 
the Split Data into Lines at Points field. 

 

Click Merge in the bottom of the Merge Files dialog. In case any of your files has no base channel, a message will warn 

you that the merging has failed. If the merging is successful, the Next Step dialog appears: 

 

In this dialog: 

 
 Select Start Another Merging Process if you want to merge one more file with the two already merged or to 

merge another pair of files. This brings the Merge Files dialog back. Repeat the steps described above as many 

times as needed. 

 Select Open the Result File in Read-Only Mode if you do not want to change the merged file. 

 Select Open the Result File in Read/Write Mode if you want to change the merged file. 

 Select Exit to quit the Merge Files application. 

 Click Continue to close the dialog. 

Interpolating Data 

This functionality is accessible only if your data contain a base channel (e.g. Fiducial) which may be both in an ascending 

and descending order. Interpolation is especially useful when you merge two or more files and there are a lot of missing 

data as a result. You can also use it to replace existing data that you consider doubtful by interpolated. In this case, select 
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these data, right-click on them, and choose Set Dummy Values from the popup menu to appear. This will substitute your 

data with asterisks. 

 

 Select Tools/Data Channels/Interpolate Channels. The Channel Interpolation dialog appears: 
 

 Choose the base channel from the dropdown list in the upper section. If your data contain the Fiducial channel, it 
is selected by default. To use the record number N as a base channel, check the respective box. 

 Select the channel(s) for interpolation from the list below. 

 Check the For All Lines box to interpolate data in all lines. This box unchecked, your data are interpolated only 
within the line you are currently working with. 

 If you checked the For All Lines box, select Each line separately if you want interpolation to be line-specific 
and Through the file if you want it to be continuous, throughout all of the lines. 

 

 Click Interpolate. 

 

Digital Filter 

Click the Processing -> Filters -> Digital Filter. The dialog appears. 

 
 

 
 

 Select a data channel for filtering 
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 Select a data range if need 

 Select output mode. If create mode is chosen, a new channel will be inserted after base channel 

 Select file type: Mean filter, Median filer and Gaussian filter 

 Click the Run button to filter data 

 

FFT Filter 

Click the Processing -> Filters -> FFT Filter. The dialog appears. 

 
 

 
 
 

 Select a data channel for filtering 

 Select a data range if need 

 Select output mode. If create mode is chosen, a new channel will be inserted after base channel 

 Select file type: Low pass filter, high pass filter, Band pass and Band remove filter 

 Input a number of replace data or window width 

 Select a sample channel or input a number of sample rate or sample interval 

 Click the Run button to filter data 

 Click the Transform only button to transform data 

 Check the Display transform. The dialog changes as 
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 Click   Save transform Info   to save the transform information to a specified QCT file 

 

Derivatives By FFT 

Click the Processing -> Gravity data Processing -> Derivatives by FFT. The dialog appears. 
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 Select a data channel for derivation 

 Select data channels for coordinates 

 Click the button of ADV   to set the information of Output grid information 

 Click Apply to calculate 

Appending files 

In some cases, you need to append, or attach, one file to another. 

 
Select Tools/Append Files on the QCTool menu. In the respective dialog that appears: 
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 Click the Open button in the File 1 section to browse for the first file. 

 Click the Open button in the File 2 section to browse for the file to append. 

 Compare the File 1 and File 2 columns in the respective table below. 

If a File 2 column does not coincide with a File 1 column, you can always change the former to match the latter. Click on it 

and select a required column from the dropdown list to appear. 

 

 Click the Open button  in the Save Results in File section to specify the file to save your newly created data 
set in. 

 Click Append. Your new file appears in the current window. 

Sorting by Channel 

To sort your data by channel: 

 

 Select Tools/Data Channels/Sort All by Channel. In the dialog to appear: 
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 Select the channel to sort your data by from the Sort by dropdown list and specify the Ascending or 
Descending order on the right. 

 

 To specify the secondary sort order of your data, check the Then by box. The section below is activated. Select 
the channel to sort by from the dropdown list and specify the Ascending or Descending order on the right. 

 

 In the bottom Apply section, select For all Lines to sort your data by the specified channel throughout all of the 
lines and For the current Line only to sort data within the line you are currently working with. 

 

 Click Sort. 
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QCTool Reference 

File menu commands 

The File menu offers the following commands: 

 
       Open QCT File Opens an existing qct-file. 

 
Close Closes an opened qct-file. 

 
       Save QCT file Saves an opened qct-file using the same file name. 

 
Save As Saves an opened qct-file to a specified file name. 

 
Import File Import data from a specified file name. 

 

Print 
Prints a map from the Grid Mapping Window  

 

Print Preview Displays the document on the screen as it would 

appear printed. 

 
Print Setup Selects a printer and printer connection. 

 
       File Manager Invokes a dialog to manage the opened qct-files. 

 
Exit Exits QCTool 

 

 

Open command (File menu) 

Use this command to open an existing qct-file in a new spreadsheet window. 

 
Shortcuts 

 
 

Toolbar: 

 
Keys:CTRL+O 

 

Close command (File menu) 

Use this command to close all windows containing the active file. QCTool suggests that you save changes to your file 

before you close it. If you close a file without saving, you lose all changes made since the last time you saved it. 

 

Save command (File menu) 

Use this command to save the active file to its current name and directory. If you want to change the name and directory 

or file format of an existing file before you save it, choose the Save As command. 

 
Shortcuts 

 

Toolbar:  
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Keys:CTRL+S 

 

Save As command (File menu) 

Use this command to save and name the active file. QCTool displays the Save As dialog box so you can name your 

document. 

 
To save a document with its existing name and directory, use the Save command. 

 

File Save As dialog box 

The following options allow you to specify the name and location of the file you're about to save: 

 
File Name 

 
Type a new filename to save a document with a different name. QCTool adds the extension you specify in the Save File 

As Type box. 

 
Drives 

 
Select the drive in which you want to store the document. 

 
Directories 

 
Select the directory in which you want to store the document. 

 
Network... 

 
Choose this button to connect to a network location, assigning it a new drive letter. 

 
Save As Type 

 
You can choose different file type from the list: 

 
QCT-file; 

 
XYZ ASCII file; 

Microsoft Excel; 

Geosoft GBN file. 

See Also 

 
Saving Files 

 

Exit command (File menu) 

Use this command to end your QCTool session. You can also use the Close command on the application Control menu. 

QCTool prompts you to save documents with unsaved changes. 

 
Shortcuts 

 
Mouse:Double-click the application's Control menu button. 
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Keys:ALT+F4 

 

Edit menu commands 

The Edit menu offers the following commands: 

 
   Undo Reverse previous editing operation. 

   Cut Deletes data from the spreadsheet and moves it to the clipboard. 

   Copy Copies data from the spreadsheet to the clipboard. 

   Paste Pastes data from the clipboard into the spreadsheet. 

Note: Edit menu functions not implemented in the current version 

View menu commands 

The View menu offers the following commands: 

 
Toolbar Shows or hides the toolbar. 

Status Bar Shows or hides the status bar. 

Window menu commands 

The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in 

the application window: 

 
New Window Creates a new window that views the same document. 

Cascade Arranges windows in an overlapped fashion. 

Tile Horizontally Arranges windows Horizontally. 

Tile Vertically Arranges windows Vertically. 

Arrange Icons Arranges icons of closed windows. 

 

 
Help menu commands 

The Help menu offers the following commands, which provide you assistance with this application: 

   Help Topics Offers you an index to topics on which you can get help. 

About Displays the version number of this application. 

 

 
Toolbar 
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The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick mouse 

access to many tools used in QCTool, 

 
To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

 
ClickTo 

 

Open an existing qct-file. QCTool displays the Open dialog box, in which you can locate and open the desired file. 

 

     Save the active qct-file with its current name. 

    Invoke a dialog to manage the opened qct-files. You can close, hide or activate different view windows of the 
opened file. 

 

    Show/hide the spreadsheet window of active qct-file. 

    Show/hide the plotter window of active qct-file. If plotter is called first time the data from selected column will be 
plotted 

 

    Show/hide the profile viewer of active qct-file. 

 Indicate a selected line from a list of existed. . 

    Invoke a dialog with line information. 

    Cut the current line at a selected point. 

    Mark the selected line as a deleted. 

    Mark the selected points (locations) as a deleted. 

    Insert a new point (location). 

    Insert points (locations) . 
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QCTool(R) 

Copyright (C) 2006-2025  Eikon Technologies LTD 

All Rights Reserved 

 

QCTool SOFTWARE LICENSE 

EIKON TECHNOLOGIES LTD 

 
You should carefully read the following terms and conditions before using this software. Unless you have a 

different license agreement signed by EIKON TECHNOLOGIES LTD. ("ETL", by using, copying, 

transmitting, distributing or installing QCTool, you agree to all of the terms of this license. 

 
If you do not agree to any of the terms of this license, then do not install, distribute, transmit, copy or use 

QCTool. If you have paid ETI or an authorized ETI distributor for this copy individually, you may return 

it unused, within thirty (30) days after purchase, for a full refund of your payment minus costs. 

 
When this copy of QCTool has been registered, it may be installed on a single workstation used by a single 

person or used non-simultaneously by multiple people. This is not a concurrent use license. 

 
The license is granted to the purchaser and is non-transferable to either another individual, company, 

organization or department within an organization. 

 
Until QCTool has been registered, it is a free evaluation software. Subject to the terms below, you are hereby 

licensed by ETI to use this software for evaluation purposes for up to thirty (30) days without charge. 

 
You may, without making any payment to ETL or its agents: 

a) give exact copies of the evaluation version of QCTool personally to anyone; 

b) distribute exact copies of the evaluation version of QCTool, if done exclusively through electronic 

channels; 

and 

c) produce as many exact copies of the evaluation version of QCTool as you wish, for purposes of distribution 

as described in (a) and (b) above. 

 
YOU ARE SPECIFICALLY PROHIBITED FROM CHARGING, OR REQUESTING DONATIONS, FOR 

ANY COPIES, HOWEVER MADE, AND FROM DISTRIBUTING SUCH COPIES WITH OTHER 

PRODUCTS OF ANY KIND, COMMERCIAL OR OTHERWISE, WITHOUT PRIOR WRITTEN 

PERMISSION FROM ETI. 

 
ETI RESERVES THE RIGHT TO REVOKE THE ABOVE DISTRIBUTION RIGHTS AT ANY TIME, 

FOR ANY OR NO REASON. 

 
You may not alter or modify the Software, nor give anyone permission to do so. 

 
THIS SOFTWARE, AND ALL ACCOMPANYING FILES, DATA AND MATERIALS, ARE 

DISTRIBUTED "AS IS" AND WITH NO WARRANTIES OF ANY KIND, WHETHER EXPRESS OR 

IMPLIED. Good data processing procedure dictates that any program be thoroughly tested with non-critical 

data before relying on it. The user must assume the entire risk of using the program. THIS DISCLAIMER OF 

WARRANTY CONSTITUTES AN ESSENTIAL PART OF THE AGREEMENT. 

 
ANY LIABILITY OF ETI WILL BE LIMITED EXCLUSIVELY TO REFUND OF PURCHASE PRICE. IN 
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ADDITION, IN NO EVENT SHALL ETI, OR ITS PRINCIPALS, SHAREHOLDERS, OFFICERS, 

EMPLOYEES, AFFILIATES, CONTRACTORS, SUBSIDIARIES, OR PARENT ORGANIZATIONS, BE 

LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE DAMAGES WHATSOEVER 

RELATING TO THE USE OF QCTool, OR YOUR RELATIONSHIP WITH ETI. 

 
IN ADDITION, IN NO EVENT DOES ETI AUTHORIZE YOU TO UTILIZE QCTool IN APPLICATIONS 

OR SYSTEMS WHERE QCTool's FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO 

RESULT IN A SIGNIFICANT PHYSICAL INJURY, OR IN LOSS OF LIFE. ANY SUCH USE BY YOU IS 

ENTIRELY AT YOUR OWN RISK, AND YOU AGREE TO HOLD ETI HARMLESS FROM ANY 

CLAIMS OR LOSSES RELATING TO SUCH UNAUTHORIZED USE. 

 
This Agreement is the complete statement of the Agreement between the parties on the subject matter, and 

merges and supersedes all other or prior understandings, purchase orders, agreements and arrangements. This 

Agreement shall be governed by the laws of the Province of Ontario. Exclusive jurisdiction and venue for all 

matters relating to this Agreement shall be in courts and forums located in the Province of Ontario, and your 

consent to such jurisdiction and venue is implied. 

 
 

Ordering Information. 

The following information is for the English language version of QCTool. 

All orders are subject to the QCTool License Agreement. 

 
To order QCTool online, please click the "Buy Now" button on the prices page of the QCTool website. 

 
You will receive your Registration Number by email within one business day after the payment is processed. 

Website: www.QCTOOL.ca 

http://www.qc-tool.com/prices.php
http://www.qctool.ca/

